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PREFACE

Thank you for purchasing Analog Devices, Inc. development software for

digital signal processing (DSP) applications.

Purpose of This Manual

The VisualDSP++ 5 Licensing Guide describes how to manage your license
for Visual DSP++ software. For users who purchase floating licenses, this
guide also describes the Floating License Server.

This manual does not describe licensing versions of Visual DSP++ prior
to release 5. For information about older versions, contact Licensing

Support.

Intended Audience

The primary audience of this book is anyone who works with
VisualDSP++®, a licensed product from Analog Devices. It describes the
product licensing options, installation, and activation. The guide also
includes the troubleshooting and FAQ sections for licensing issues.

Visual DSP++ 5 Licensing Guide ix



Manual Contents

Manual Contents

The manual contains:

Chapter 1, “Licensing Overview”
Describes the available Visual DSP++ license types and licensing
options.

Chapter 2, “Installing a Node-Locked License”
Details how to install a node-locked license.

Chapter 3, “Installing a Floating License Server”
Details how to install floating licenses and set up the license server.

Chapter 4, “Registering and Validating Your License”
Details the process of registering and validating your license in
order to make it permanent.

Chapter 5, “Checking the Status of Your License”
Describes the status (as shown in the About dialog box) for each
Visual DSP++ license type.

Chapter 6, “Troubleshooting”
Explains commonly encountered error messages and provides
answers to frequently asked questions.

Appendix A, “Licensing Support”
Describes how to contact Analog Devices regarding licensing
issues.
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What’s New in This Manual

This revision of the VisualDSP++ Licensing Guide includes modifications
and corrections based on the latest revision of VisualDSP++.

Refer to VisualDSP++ 5.1 Release Notes for information about new and
updated features.

Technical Support

You can reach Analog Devices processors and DSP technical support in
the following ways:

e DPost your questions in the processors and DSP support community
at EngineerZone™:
http://ez.analog.com/community/dsp

* Submit your questions to technical support directly at
http://www.analog.com/support

* E-mail your questions about processors, DSPs, and tools develop-
ment software from CrossCore Embedded Studio or
VisualDSP++:

Choose Help -> Email Support. This creates an e-mail to
processor.tools.support@analog.com and automatically attaches
your VisualDSP++ version information and Ticense.dat file.

* E-mail your questions about processors and processor applications
to:
processor.support@analog.com or
processor.china@analog.com (Greater China support)

* In the USA only, call 1-800-ANALOGD (1-800-262-5643)
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Supported Processors

* Contact your Analog Devices sales office or authorized distributor.
Locate one at:
www.analog.com/adi-sales

* Send questions by mail to:
Processors and DSP Technical Support
Analog Devices, Inc.
Three Technology Way
P.O. Box 9106
Norwood, MA 02062-9106
USA

@ For licensing support, contact Licensing Support.

Supported Processors

This manual documents support for the following Analog Devices, Inc.
processors.

¢ Blackfin® (ADSP-BFxxx)
¢ SHARC® (ADSP-21xxx)
¢ TigerSHARC® (ADSP-TSxxx)

The majority of the information in this manual applies to all processors.
For a complete list of processors supported by Visual DSP++ 5, refer to the
online Help.

Product Information

Product information can be obtained from the Analog Devices Web site
and CrossCore Embedded Studio online help system.
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Analog Devices Web Site

The Analog Devices Web site, www.analog.com, provides information
about a broad range of products—analog integrated circuits, amplifiers,
converters, and digital signal processors.

To access a complete technical library for each processor family, go to
http://www.analog.com/processors/technical_library. The manuals
selection opens a list of current manuals related to the product as well as a
link to the previous revisions of the manuals. When locating your manual
title, note a possible errata check mark next to the title that leads to the
current correction report against the manual.

Also note, MyAnalog.com is a free feature of the Analog Devices Web site
that allows customization of a Web page to display only the latest infor-
mation about products you are interested in. You can choose to receive
weekly e-mail notifications containing updates to the Web pages that meet
your interests, including documentation errata against all manuals. MyAna-
log.com provides access to books, application notes, data sheets, code
examples, and more.

Visit MyAnalog.com to sign up. If you are a registered user, just log on.
Your user name is your e-mail address.

EngineerZone

EngineerZone is a technical support forum from Analog Devices. It allows
you direct access to ADI technical support engineers. You can search
FAQs and technical information to get quick answers to your embedded
processing and DSP design questions.

Use EngineerZone to connect with other DSP developers who face similar
design challenges. You can also use this open forum to share knowledge
and collaborate with the ADI support team and your peers. Visit
http://ez.analog.com to sign up.
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Notation Conventions

Notation Conventions

Text conventions in this manual are identified and described as follows.

Example

Description

File -> Close

Titles in bold style indicate the location of an item within the Visu-
alDSP++ environment’s menu system (for example, the Close com-
mand appears on the File menu).

{this | that}

Alternative required items in syntax descriptions appear within curly
brackets and separated by vertical bars; read the example as this or
that. One or the other is required.

[this | that]

Optional items in syntax descriptions appear within brackets and sepa-
rated by vertical bars; read the example as an optional this or that.

[this,..] Optional item lists in syntax descriptions appear within brackets delim-
ited by commas and terminated with an ellipse; read the example as an
optional comma-separated list of this.

.SECTION Commands, directives, keywords, and feature names are in text with
letter gothic font

filename Non-keyword placeholders appear in text with italic style format.

®

Note: For correct operation, ...
A note provides supplementary information on a related topic. In the
online version of this book, the word Note appears instead of this

symbol.

Caution: Incorrect device operation may result if ...

Caution: Device damage may result if ...

A Caution identifies conditions or inappropriate usage of the product

that could lead to undesirable results or product damage. In the online
version of this book, the word Caution appears instead of this symbol.

N

Warning: Injury to device users may result if ...

A Warning identifies conditions or inappropriate usage of the product
that could lead to conditions that are potentially hazardous for devices
users. In the online version of this book, the word Warning appears
instead of this symbol.

X1v
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1 LICENSING OVERVIEW

This chapter describes licensing options available for Visual DSP++ 5

users.

The following topics are covered:

Supported Platforms

System Requirements

Using this Book

Upgrading to VisualDSP++ 5 from Earlier Versions
Licensing Options

Obtaining a License Serial Number
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Supported Platforms

Supported Platforms

Visual DSP++ 5 is supported on the following operating systems:

N

Windows 2000® SP4

Windows XP Professional SP3 (32-bit only)

Windows 7 Professional, Enterprise, or Ultimate (32- and 64 -bit)
Windows® 8 Pro and Enterprise

Windows Vista Business, Enterprise, or Ultimate SP2 (32-bit
only)

Windows Vista, Windows 7, and Windows 8 users may experience
User Access Control (UAC) related errors if the software is
installed into a protected location, such as Program Files or Pro-
gram Files (x86). We recommend installing the software in a
non-UAC-protected location.

If using Windows 7 or later, refer to DOC-1190 on the FAQ page at
http://ez.analog.com.

If using Windows Vista with User Account Control enabled, refer to
“Windows Vista Compatibility in VisualDSP++ 5.0 Development Tools”
(EE-330) at
http://www.analog.com/en/processors-dsp/blackfin/products/appli-

cation-notes/resources/index.html.

VisualDSP++ License Manager

The VisualDSP++ License Manager is supported on Windows Server 2003
and all operating systems listed in this section.

1-2
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Licensing Overview

System Requirements

Verify that your PC has these minimum requirements for the Visu-
alDSP++ 5 installation:

* 1 GHz single-core processor
* 512 MB RAM

* 2 GB available disk space

* One open USB port

A faster disk drive decreases the build time, especially for a large
amount of source files .

Using this Book

If you are upgrading to Visual DSP++ 5 from an earlier release, read

Upgrading to Visual DSP++ 5 from Earlier Versions.
If you want to use a node-locked license, read:

* Obtaining a License Serial Number for information on obtaining a
license if you do not have one yet

* Installing a Node-Locked License for instructions on how to install
your node-locked license

* Registering and Validating Your License for instructions on how to
register and validate your license

* Checking the Status of Your License for instructions on determin-
ing the current status for an installed license
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Using this Book

If you want to use a floating license, read:

e Obtaining a License Serial Number for information on obtaining a
license if you do not have one yet

* Installing a Floating License Server for instructions on setting up a
floating license server

* Registering and Validating Your License for instructions on how to
register and validate your license

e Checking the Status of Your License for instructions on determin-
ing the current status for an installed license

If you have a question about, or a problem with, your license, read Trou-
bleshooting, which explains commonly encountered error messages and
provides answers to frequently asked questions.

If you require assistance with any licensing issues, refer to Licensing

Support.

Further Reading

For information on FLEXnet licensing, see the FLEXnet Licensing End
User Guide, which is installed with both VisualDSP++ 5 and Floating
License Server software.

In the VisualDSP++ 5 installation, the document is located in the
<install_path>\Docs\Flex folder.

In the Floating License Server installation, the document is located in the
<install_path>\LMSERVER folder.

Additional frequently asked questions and information on recently discov-
ered licensing anomalies can be found in the FAQs section of the ADI
EngineerZone, at http://ez.analog.com.
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Licensing Overview

Upgrading to VisualDSP++ 5 from Earlier
Versions

Starting with revision 5, VisualDSP++ supports FLEXnet license
borrowing, to allow use of a MAC address as host ID, and to permit
node-locked licenses to work with a Remote Desktop.

These changes have lead to a modification to the format of VisualDSP++
license strings, and therefore validation codes. This means that when you
register your serial number and host ID, two validation codes will be
e-mailed to you. One is valid for VisualDSP++ 4.5 and earlier versions;
the other is valid for Visual DSP++ 5 and later versions. Ensure that you
install the appropriate validation code for the version of VisualDSP++ that
you are using.

When upgrading to Visual DSP++ 5 from an earlier release of the tools,
you can do either of the following:

* During installation of VisualDSP++ 5, choose to copy an existing
lTicense.dat file into your Visual DSP++ 5 <install_path>\System
folder, or do so manually once VisualDSP++ 5 has been installed.
This option will allow you to get up and running immediately, but
will mean that the new features mentioned above will not be

enabled.

* During installation of VisualDSP++ 5 choose not to copy an exist-
ing license.dat file into your VisualDSP++ 5
<install_path>\System folder. Instead, install your serial num-
bers, then re-register them, and re-validate them. See Registering
and Validating Your License for further details. This option will
enable the new features mentioned above.

If you do copy an existing 1icense.dat file from an earlier version of
VisualDSP++ during installation of VisualDSP++ 5, and later wish to use
any of the new features, you must move your 1icense.dat file out of the
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Licensing Options

way (renaming it to something like 1icense_45.dat so you can identify it
later if necessary), and then re-install your serial numbers, re-register
them, and re-validate them.

The 1icense.dat files created by Visual DSP++ 5 work with
Visual DSP++ 4.5 and VisualDSP++ 4.0. This may be useful if,

for any reason, you need to revert to an earlier version of the tools.

Licensing Options

Visual DSP++ licenses are architecture specific; a separate license is
required for each of the processor architectures (Blackfin, SHARC, and
TigerSHARC) supported by VisualDSP++.

Visual DSP++ licenses are version-independent. Most serial numbers that
worked with previous versions of Visual DSP++ also work with

VisualDSP++ 5.

Licenses are issued in the form of a unique serial number and typically
take the following form:

M *
Full License ADT - XXX~ XXX~ XXXXXXX = XXX
Evaluation License KIT=XXX= XXX XXXXXXX = XXX
Test Drive License TST-XXX XXX~ XXXXXXX = XXX

Note: “x” represents a digit (0-9).
This section also covers the following topics.

e Node-Locked Licenses

* Floating (Client-Server) Licenses
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Licensing Overview

Node-Locked Licenses

Occasionally referred to as a single user license or a per user license,
a node-locked license is locked to the host ID of the host computer and

provides a single license “seat”. Once installed, Visual DSP++ runs on that
one machine only.

You may install and register the software on additional machines for your

exclusive use, but each request for registration is handled by Analog
Devices on a case-by-case basis.

The three distinct types of available node-locked licenses (Full Licenses,
Evaluation Licenses, and Test Drive Licenses) are described next.
The debug sessions enabled by each type of license are summarized in

Table 1-1.

Table 1-1. Debug Sessions vs. Licenses

Full License Evaluation License Test Drive License
Debug Session (ADI serial number) (KIT serial number) (TST serial number)
EZ-KIT Lite Yes Yes No
Emulator Yes Yes Yes
90 days only 90 days only
Refer to the note below
Simulator Yes Yes Yes
90 days only 90 days only

Refer to the note below

Note: The initial 90-day period incorporates all the capabilities of a “full license”. After 90 days
(unless you have upgraded the license to a full license), simulator and emulator connections
become prohibited and user program size becomes limited.

Full Licenses

Occasionally referred to as an unrestricted license or a permanent license, a

full license (whether node-locked or floating) enables simulator, emulator,
and EZ-KIT Lite debug sessions.
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Licensing Options

Once installed, a full license must be registered and validated within
30 days; otherwise, Visual DSP++ will become inoperable until it is
validated.

Evaluation Licenses

Occasionally referred to as an EZ-KIT license or a demo license,

an evaluation license is a permanent, but restricted license. An EZ-KIT
Lite license incorporates an initial 90-day full license. Once the 90 days
have passed, the evaluation license becomes restricted, prohibiting
simulator debug sessions and emulator debug sessions and restricting the
amount of internal memory that is available for code (program memory).

Once installed, an evaluation license must be registered and validated
within 10 days; otherwise, VisualDSP++ will become inoperable until it is
validated.

Evaluation licenses may be installed only once per machine.
Therefore, back up your <install_path>\System\license.dat file.

Test Drive Licenses

A test drive license is a temporary license, currently issued for 90 days,
after which it expires and renders Visual DSP++ inoperable. This type of
license enables emulator debug sessions and simulator debug sessions only.

Test drive licenses do not require validation.

Test drive licenses can be installed only once per machine.
Therefore, back up your <install_path>\System\license.dat file.
Also, a test drive license cannot be installed if an evaluation license
for the same architecture is already installed (or has ever been
installed) on the same machine.
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Licensing Overview

Floating (Client-Server) Licenses

Floating licenses have two parts: a server, and a client. The Floating
License Server manages the license pool stored on the server. One serial
number is installed on the server for each single seat or 5-seat package. In
this model, there can be as many client installations as desired. Each time
a user starts VisualDSP++ on a client machine, one license is “checked
out” from the server. When the user exits Visual DSP++, the license is
returned (checked back in) to the server. As long as there are available
licenses on the server, clients can use Visual DSP++.

For example, assume that your license server is configured with

10 licenses, and you have set up 20 client machines in three labs. Any

10 developers may use Visual DSP++ concurrently. When the 11th devel-
oper tries to connect, an error is emitted. This type of configuration
permits the sharing of software resources in an environment that requires
more locations than developers.

As of VisualDSP++ 5, the FLEXnet license borrowing feature is
supported. Refer to License Borrowing for details.

Only full licenses are available as floating licenses. Evaluation
licenses and test drive licenses are not available as floating licenses.

Single-Seat vs. 5-Seat Floating Licenses

Floating licenses are available in both the “single-seat” or “5-seat” bundle
options, where “seat” refers to the number of concurrent licenses that may
be checked out while using VisualDSP++.
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Obtaining a License Serial Number

Obtaining a License Serial Number

This section contains the following topics:
e Full Licenses and Evaluation Licenses
e Test Drive Licenses

* Locating License Serial Numbers Already Installed in Visual DSP++

Full Licenses and Evaluation Licenses

Full licenses and evaluation licenses may be purchased in the following
ways.

You can buy licenses directly from Analog Devices or from a local
distributor. Obtain information about Analog Devices sales offices and
local distributors in your area from the Analog Devices Web site at
http://www.analog.com/salesdir/continent.asp.

Depending on your location, you may also be able buy direct via the
Analog Devices Web site’s Buy Online facility at

http://www.analog.com/commerce/index.html.

When you purchase your copy of VisualDSP++, you will receive a card
bearing your license serial number.

Test Drive Licenses

In order to receive a test drive license, you must register online at
www.analog.com/adi-sales.

If you have registered for a Blackfin or SHARC test drive license, a TST
serial number will be e-mailed to you when you click the Register button.

Otherwise, the TST serial number will be displayed on the next page, when
you click Register.
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Licensing Overview

Locating License Serial Numbers
Already Installed in VisualDSP++

To find a serial number of the licenses already installed in VisualDSP++,
do one of the following;:

* (Node-locked licenses) Start -> All Programs -> Analog Devices ->
Visual DSP++ 5 <version_number> -> Manage Licenses.

* (Floating licenses) Start -> All Programs -> Analog Devices ->
VisualDSP++ Floating License Server -> Visual DSP++ License
Manager.
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Obtaining a License Serial Number
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2 INSTALLING A
NODE-LOCKED LICENSE

This chapter assumes that you have already installed VisualDSP++ 5 and
obtained a license serial number.

If you are upgrading to VisualDSP++ 5 from an earlier version,

read Upgrading to Visual DSP++ 5 from Earlier Versions.
The chapter describes:
* Opening the About Dialog Box
* Entering Your Serial Number

This chapter does not cover the installation of the client license
part of a floating license. For information about installing client
licenses, refer to Installing a Floating License Server.

Opening the About Dialog Box

To install a node-locked license, the serial number must be entered via the
Licenses page of the About dialog box (Figure 2-1), which can be accessed
in any of the following ways:

From the Windows Start menu, go to All Programs -> Analog Devices ->
VisualDSP <version_number> -> Manage Licenses.
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Opening the About Dialog Box

 Start VisualDSP++ while pressing and holding down the Ctrl key
until the Session Wizard appears. Then click Licenses.

* From within the Visual DSP++ IDDE, choose Help ->
About Visual DSP++, and then click the Licenses tab.

[»] About HE

General Licenses |\k=m'ms| &.lppmll

Seial Number || Famiy | Status |

Host ID
new| pezE|| | M1

Figure 2-1. Licenses Page of the About Dialog Box

Also, when starting VisualDSP++ for the first time, if a 1icense.dat file
has not been copied from an existing installation of VisualDSP++ during
the installation process, you encounter the following message and are
prompted to install a license.

A valid license could not be found. Click Yes to install a
license at this time. Click No to close VisualDSP++.
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Installing a Node-Locked License

Entering Your Serial Number

From the Licenses page of the About dialog box, enter your serial number,
as follows:

1. Click New.
The Install New License dialog box (Figure 2-2) appears.
install New License HE

“r'ou are about b install a software license ta run YisualDSP++.

Fleaze zelect one of the following license types:

& Hode-Locked license or Test Drive license

' Client license

Drescription

Thiz licenze type allows you to uge the VisualDSP++ toolz on a single
computer. Please enter your serial number exactly az it appears on the
registration card, CD sleeve or web site.

Serial number: I

()8 I Cancel |

Figure 2-2. Install New License Dialog Box

2. Select Node-locked license or Test Drive license (default).

3. In Serial number, enter your serial number exactly as it appears,
including dashes.

4. Click OK.
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The following (or similar) success message appears.

Visual DSP++

i The serial number has been successfully entered.
' This license will expire in 30 days. You must
register your productto obtain a permanentlicense.

Figure 2-3. Success Message

A license.dat file has now been created in your <install_-
path>\System folder.

@ If you are using Windows Vista (or later) and have User Account

Control enabled, the 1icense.dat file is saved to your Virtual -
Store directory:
C:\Users\<user_name>\AppData\lLocal\VirtualStore\Program
Files\Analog Devices\VisualDSP <version_number>\System.

For details, refer to “Windows Vista Compatibility in VisualDSP++ 5.0
Development Tools” (EE-330) at

http://www.analog.com/en/processors-dsp/blackfin/products/appli-
cation-notes/resources/index.html.

If using Windows 7 or later, refer to DOC-1190 on the FAQ page at
http://ez.analog.com.

At this time, your license have been activated for a temporary period only.
Your newly installed serial number appear on the Licenses page of the
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About dialog box, with the following status, depending on the type of
license you have installed:

e ADI-prefixed serial numbers display as
Not Validated (Expiring in 30 days)

e KIT-prefixed serial numbers display as
Not Validated (Expiring in 10 days)

e TST-prefixed serial numbers display as
Test Drive (Expiring in 90 days)

An example appears in Figure 2-4:

[»] About 21=]

General  Licenses |\|’ersion5 I Support I

Serial Number | Fami Status
ADI-256-256-25625256-256  Blackfin Mot Validated (Bxpiring in 30 days)

1 | ]

Host ID
New... | Hegister.. | Yaldate. ||£|

Figure 2-4. Serial Number Installed

In order to make your full license or evaluation license permanent, you
must validate the license. You obtain the necessary validation code by reg-
istering online.

If you do not validate your license during the temporary license period,
your license will cease to function until it is validated. Refer to Registering
and Validating Your License.
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3 INSTALLING A FLOATING
LICENSE SERVER

There are two parts to floating licenses: server and client. The server
manages the license pool stored locally on the server. The clients
“check-out” and return licenses to the server as needed, when
Visual DSP++ is started and exited.

This chapter describes all the steps required to install floating licenses.
First, the Floating License Server (version 2.00.7 or later is compatible
with VisualDSP++ 5) and server license(s) are installed on your server
machine. Second, Visual DSP++ 5 and your client license(s) are installed
on your client machine(s).

This chapter also describes the FLEXnet license borrowing feature,
which is new to VisualDSP++ 5.

If you are upgrading to VisualDSP++ 5 from an earlier version,

read Upgrading to Visual DSP++ 5 from Earlier Versions.
The chapter is organized as follows:
e Server Machine

¢ (Client Machine

* License Borrowing
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Server Machine

There are two parts to the Visual DSP++ Floating License Server:
e VisualDSP++ License Manager
* FLEXnet (formerly called FLEXIm) LMTOOLS

Your floating license serial number is installed through the Visual DSP++
License Manager. A Windows service must then be configured and started
using FLEXnet LMTOOLS.

If you are installing the Floating License Server for the first time, go
directly to Task 1B: Installing the VisualDSP++ Floating License Server.

If you are upgrading an existing installation of the VisualDSP++ Floating
License Server, first you must disable and uninstall this existing installa-
tion as described in Task 1A: Disabling and Uninstalling an Existing
Floating License Server, and then install the new version.

Version 2.00.7 and later of the Floating License Server are compat-

ible with Visual DSP++ 4.0, VisualDSP++ 4.5, and Visual DSP++ 5.
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Task 1A: Disabling and Uninstalling an Existing
Floating License Server

You must perform the following procedure if you are upgrading an
existing installation of the VisualDSP++ Floating License Server.
The procedure disables and then uninstalls the software.

Uninstalling the Floating License Server tools from Add/Remove pro-
grams leaves your 1icense.dat file intact in the <install_path>\LMSERVER
directory. This means that you can simply re-use your original
license.dat file and skip Task 2.

However, to take advantage of the new license borrowing feature
introduced in VisualDSP++ 5 and version 2.00.7 of the Floating License
Server, you must move your existing 1icense.dat file out of the way and
re-install and re-validate your serial numbers. From VisualDSP++ 5
onwards, license strings (and therefore validation codes) have changed in
format. This means that you need to re-register all your serial numbers
and install the version 5-compatible validation codes sent to you.

For further details, see Registering and Validating Your License.

@ Save your <install_path>\LMSERVER\Ticense.dat file to a safe
place before proceeding.

1. From the Windows Start menu, choose All Programs -> Analog
Devices -> Visual DSP++ Floating License Server -> FLEXnet
LMTOOLS.

The LMTOOLS window appears.
2. Click the Start/Stop/Reread tab and click Stop Server.
3. Close LMTOOLS.
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In the Windows Control Panel, open Add/Remove Programs and
uninstall Visual DSP++ Floating License Server (or VisualDSP++
License Manager Server, as it was named in earlier versions).

Reboot the machine.

Task 1B: Installing the VisualDSP++ Floating License

Server

The following one-time procedure installs the VisualDSP++ Floating
License Server, consisting of the Visual DSP++ License Manager and
FLEXnet LMTOOLS.

1.

Download the Floating License Server Installer from the

Visual DSP++ Downloads and Updates Web page at
http://www.analog.com/en/processors-dsp/software-and-ref-
erence-designs/content/visualdsp_tools_upgrades/fca.html.

Navigate to the download target folder, and unzip the VisualDSP_-
FLS_xxxx.zip file.

Run setup.exe.

The InstallShield wizard appears.

3-4
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4. Follow the prompts.

The wizard completes the Floating License Server installation. The
default installation path is shown in Figure 3-1.

Install Shield Wizard E
Start Copying Files

Fieview settings before copying files.

Setup has enough information to start copying the program files. 1F you want to review or

change any settings, click Back. If you are satisfied with the settings, click Mest to begin
copying files.

Current Settings:

Files will be placed in: :I
C:\Program Fileghdnalog Devices\YizualDSPALMSERVER

Installing the following:
WizualD SP++ Floating License Server 2.00.7

K

| Frztal Shield

< Back

Figure 3-1. InstallShield Wizard

A client-license.dat file have been created, ready for installation
on your client machine (see Task 4: Installing a Client License).

5. Copy the client-Ticense.dat file from the <install_-
path>\LMSERVER directory to a shared network folder.

Ensure that it has read-only permissions and is accessible to the
“Everyone” group.
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Task 2: Installing a Server License

If you are upgrading from an earlier release of the Floating License
Server and still have your original 1icense.dat located in the
<install_path>\LMSERVER directory, you can skip this task and

go directly to Task 3: Configuring and Starting FLEXnet
LMTOOLS.

For further details, see Task 1A: Disabling and Uninstalling an Existing
Floating License Server.

Perform the following procedure for each floating license serial number.
One serial number is installed for each single seat or 5-seat package.

1. From the Windows Start menu, choose All Programs ->
Analog Devices -> Visual DSP++ Floating License Server ->
VisualDSP++ License Manager.

The VisualDSP++ License Manager dialog box appears
(Figure 3-2).

iw VisualDSP++ License Manager ¥5.0.1.0 = B3

Serial Number | Family | seats | status [

Machine ID
Mew. .. | Hegistery.. | alidate .. | 11111111

Figure 3-2. VisualDSP++ License Manager

2. Click New.
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3. In Serial number, enter the serial number exactly as it appears,

including dashes.
4. Click OK.

Upon successful installation, a success message appears.

A license.dat file has been created and is located in your <install_-
path>\LMSERVER folder.

If you are using Windows Vista (or later) and have a User Account
Control enabled, the 1icense.dat file is saved to your Virtual -
Store directory:
C:\Users\<user_name>\AppData\lLocal\VirtualStore\Program
Files\Analog Devices\VisualDSP <version_number>\System.

For details, refer to “Windows Vista Compatibility in VisualDSP++ 5.0
Development Tools” (EE-330) at
http://www.analog.com/en/processors-dsp/blackfin/products/appli-
cation-notes/resources/index.html.

If using Windows 7 or later, refer to DOC-1190 on the FAQ page at
http://ez.analog.com.

The new license is activated for a temporary period only. The newly
installed serial number will appear on the License page of the About
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Server Machine

dialog box (Figure 3-3) and will have a status of Not Validated

(Expiring in 30 days).

i Visual DSP++ License Manager v5.0.1.0 M= B3
Serial Number | Family | seats | stats
ADI-234-23423-234234-23 TigerSHA... 5 Server - Mot Yalidated (Expiring in 30 days)

4

|

Machine D ————
Cloze | Mew. .. | Hegistery.. | alidate .. | 11111111

Figure 3-3. License Page Indicating an Installed Serial Number Expiring

in 30 Days

In order to make your full floating license permanent, you must validate

it. You can obtain the necessary validation code by registering online as
described in Registering and Validating Your License.

If you do not validate the license within the temporary license
period, your license will cease to function until you validate it.

3-8

Visual DSP++ 5 Licensing Guide



Installing a Floating License Server

Task 3: Configuring and Starting FLEXnet LMTOOLS

This section describes how to configure FLEXnet LMTOOLS to run
the Floating License Server as a Windows service and how to set up the
path information for your license files.

1. From the Windows Start menu, choose All Programs ->
Analog Devices -> Visual DSP++ Floating License Server ->

FLEXnet LMTOOLS.

The LMTOOLS window appears.

2. Click the Service/License File tab and click Configuration using
services and LMTOOLS ignores license file path environment
variables. Refer to Figure 3-4.

LMTOOLS by Acreszo Saftware Inc. ME B3
File Edit Mode Help

|S_l,lstem Settingsl Utilitiesl Start.-"Stop.-"F!ereadI ServerStatusI ServerDiagsI Config Sewicesl Borrowingl

Services allow FLEXnet Servers to run in the background.

— Server List
" Configuration using Licenze File

& Configuration using Services

¥ LMTOOLS ignores license file path ervdronment variables

IND FLEXIm Services defined. use Configure Services to add services

Figure 3-4. LMTOOLS Service/License File Tab
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3. Click the Config Services tab.

LMTOOLS by Macrovision Corporation hitp-//www macrovision.com M= B3
File Edit Mode Help

Service/License FiIeI System Settingsl Utilitiesl Start.-"Stop.-"F!ereadI ServerStatusI Server Diags  Config Services | Borrowingl

Save Service |
Remove Service |

Configure Service

Service Mame IM}. Service ;I

Fath ta the Imgrd.exe file Ialog Devices\WisualD SPALMSERVER mard. exe &I

Pathto the license fle |00 DeviceshisualDSPALMSERVE Rlicense. dat e |

Fath ta the debug lag file I\nalog Devices\WizualDSPALMSERVER WMyLog | Browse  View Log...l ek el

¥ Start Server at Power Up ¥ Use Services

Figure 3-5. LMTOOLS Config Services Tab

4. Set up the options (see Figure 3-5) as follows:

In Service Name, enter the name of the new service you want to
create (or select an existing service).

Add/modify the name and paths to the existing Tmgrd.exe file and
the Ticense.dat file. Also, provide a name (<your_name>.10g) for
the log file, which will then be created if it does not already exist.

@ By default, FLEXnet LMTOOLS looks for a license file with a
.Tic extension. Files with a .dat extension (the extension used by
the Visual DSP++ License Manager) are also accepted. Simply
change the extension in the Files of Type field to License Files
(*.dat) when browsing for the file.
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Ensure that both the Use Services option and the Start Server at
Power Up option are selected.

Click Save Service to save this service to the existing list.

5. Click the Start/Stop/Reread tab (see Figure 3-6) and select your

newly created service from the list.

LMTOOLS by Macrovision Corporation hitp-//www macrovision.com M= B3
File Edit Mode Help

Service/License FiIeI System Settingsl Utiities ~ Start/Stop/Reread | ServerStatusI ServerDiagsI Config Servicesl Borrowingl

FLE*net licenze services installed on this computer

My Service

Start Server Stop Server FeRead License File

: ™ Foree Server Shutdown
Crhee] sl 26 | MWOTE: This box must be checked to shut down a license server

when licenses are borowed.

IServer Start Successful

Figure 3-6. LMTOOLS Start/Stop/Reread Tab

6. Click Start Server.
The following messages appear:
Server Starting.

Server Start Successful.

It may take up to a minute for the server to start.
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7. Click the Service Status tab (see Figure 3-7), and then click
Perform Status Inquiry.

LMTOOLS by Macrovision Corporation hitp-//www macrovision.com M= B3
File Edit Mode Help

Service/License FiIeI System Settingsl Utilitiesl Start/Stop/Fleread  Server Status | ServerDiagsI Config Servicesl Borrowingl

Helps to monitor the status of network licensing activities

Optio:

Individual Daemon I
Perfarm Status Enguiny Individual Feature l—

Server Mame I

-------- =
Status
Flexible License Manager status on Wed €/27/72007 13:Z§
[Petecting lmgrd processea. .. ]
License serwver status: EBedin-luanshya

License file{s) on sdin-luanshya: C:\Program Filesa\Analog —
DevicealViaual BSPATMSERVERY licenae dat: LI

IUsing Licenze File: C:\Program Filesh\analog Devices\isualDSPALMSERVERYicense. dat

Figure 3-7. LMTOOLS Server Status Tab, Showing Status

8. Review the server status, which should indicate success.

If there appears to be a problem, review the above procedure, ensuring
that you have followed it step-by-step.

If you have followed the procedure and problems persist, review Trouble-
shooting. If you continue to have problems, contact Support (see
Licensing Support), attaching your Ticense.dat and client-license.dat

files.
Notes

* An existing service cannot be overwritten. You can remove a service
via the Delete Service button located on the Config Services tab.

* Starting/stopping the server, performing a status inquiry, and
re-reading a Ticense.dat file may take up to a minute.
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e Whenever a change is made to the Ticense.dat file, the file must
be re-read by FLEXnet LMTOOLS. You perform this action via
the Start/Stop/Reread tab.

e If you are running multiple versions of FLEXnet (formerly called
FLEXIm) for various products, see Troubleshooting.

* If your server or client machines are running a firewall, contact
Support as described in Licensing Support for advice on how to
proceed.

Client Machine

Perform the following procedure to install a client license on a
workstation.

Task 4: Installing a Client License

The client-Ticense.dat file must be available on the server,
in a shared network folder that is accessible by all users.

1. On each workstation, install VisualDSP++ 5 and install the latest
update (if applicable).

The base release download and latest updates are available on the
Analog Devices Web site at

http://www.analog.com/en/processors-dsp/software-and-ref -
erence-designs/content/visualdsp_tools_upgrades/fca.html.
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If you are upgrading both client and server software, the server
software must be upgraded first. Begin at Task 1A: Disabling and
Uninstalling an Existing Floating License Server.

2. From the Windows Start menu, choose All Programs ->
Analog Devices ->Visual DSP++ <version_number> ->Manage
Licenses.

The Licenses page of the About dialog box appears.
3. Click New.

The Install New License dialog box appears.
4. Click Client License.

5. Click the browse (...) button to open a browser, from which to
select the c1ient-1icense.dat file.

- Or -_—

In License file, type the name of the server and the license file in
the form:
\\server_machine_name\<path_to_shared_network_folder>

\client-Ticense.dat.

You can locate the “server machine name” on the server machine
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via the Windows Start menu by choosing Settings -> Control
Panel -> System (or System Properties) -> Computer Name ->
<full_computer_name>.

6. Click OK.
The client-Ticense.dat file from your server machine will now

be copied to your client machine, renamed as 1icense.dat, and
saved to the <install_path>\Systenm directory.

General  Licenses |\|’ersion5 I Support I
Senzl Number | Family | Status |
EDIN-SHANSHAN  Client USE_SERVER

Host ID
Fegrster.. | alidate.. | 11111111
oK |

Figure 3-8. Licenses Page Showing Installed License

If you are using Windows Vista (or later) and have User Account
Control enabled, the Ticense.dat file will be saved to your Virtu-
alStore directory instead:
C:\Users\<user_name>\AppData\lLocal\VirtualStore\Program
Files\Analog Devices\VisualDSP <version_number>\System.

For details, refer to “Windows Vista Compatibility in VisualDSP++ 5.0
Development Tools” (EE-330) at

http://www.analog.com/en/processors-dsp/blackfin/products/appli-
cation-notes/resources/index.html.

If using Windows 7or later, refer to DOC-1190 on the FAQ page at
http://ez.analog.com.
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License Borrowing

If a Ticense.dat file already exists on the client machine (in
<install_path>\System), a message indicates that the current
Ticense.dat file will be renamed to Ticense.bak and the client
license will be copied to the client machine.

If you are trying to install both a client license and a node-locked license
on the same machine, refer to the relevant information in Frequently

Asked Questions (FAQs).

License Borrowing

From VisualDSP++ 5 onwards, you can “check out” a floating license
from the server for a predetermined length of time.

While a license is actively being borrowed, the server license count is
decreased, effectively providing a full, node-locked license with a fixed
expiration date.

When the set borrowing time expires, the server automatically returns the
license to the available pool, and the borrowed license on your machine
expires, disabling use of VisualDSP++.

Licenses can be returned early to the server. This capability requires
that you are connected to the network.

To initiate license borrowing, return licenses early, check the status of
borrowed licenses or stop borrowing licenses, use the Imborrow utility
provided in the Floating License Server install at <instal7_-
path>\LMSERVER. Further details can be found in the FLEXnet Licensing
End User Guide, described in Further Reading.

@ When borrowing a license, use analogd as the vendor name.
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Further Reading

For a more comprehensive overview of FLEXnet licensing, refer to the
FLEXnet Licensing End User Guide, which is installed along with both
VisualDSP++ 5 and Floating License Server software.

In the Visual DSP++ 5.1 install, this document is located in the
<install_path>\VisualDSP <version_number>\Docs\flex folder.

In the Floating License Server install, it is located in the <install_-
path>\LMSERVER folder.
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4 REGISTERING AND
VALIDATING YOUR LICENSE

This chapter explains how to register your license serial number and
obtain the validation code required to make your license permanent.

These procedures apply to full licenses and evaluation licenses only.
Test drive licenses function for 90 days and then permanently
expire. These licenses cannot be validated.

The chapter contains the following sections:
* Required Information
* Registering Your License

* Validating Your License
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Required Information

In order to register your license on the Analog Devices Web site, you must
have the following information:

¢ License serial number

e HostID

License Serial Number

Visual DSP++ license serial numbers are typically of the form:

Full license ADT = XXX~ XXX~ XXXXXX = XX
Evaluation license KIT- XXX~ XXX~ XXXXXX XX

where x represents a digit (0-9).

License serial numbers are issued on license serial cards and mailed to you
at the time of purchase.

Refer to Obtaining a License Serial Number for details about obtaining a
license serial number.

Host ID

FLEXnet licensing uses the host ID, an identifier unique to each com-
puter, to lock licenses to a particular machine.

Visual DSP++ takes the default value of the host ID as the volume (or disk)
serial number of the C:\ drive. From VisualDSP++ 5 onwards, if you do
not have a hard drive on your machine (or have a setup that results in your
machine not having a C:\ drive), the MAC address is used. The MAC

address is a unique number associated with the computer’s network card.
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Finding the Host ID for a Node-Locked License

From the Windows Start menu, choose All Programs -> Analog Devices
-> Visual DSP++ <version_number> -> Manage Licenses.

The host ID appears in the bottom-right corner of the resulting dialog box
(Figure 4-1).

[»] About HE

General Licenses |\k=m'ms| &.lppmll

Seial Number || Famiy | Status |

Host ID
new| pezE|| | 1111111
Figure 4-1. Licenses Page Showing Host ID

Finding the Host ID for a Floating License

From the Windows Start menu, choose All Programs -> Analog Devices

-> Visual DSP++ Floating License Server -> Visual DSP++ License
Manager.
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The host ID appears in the bottom-right corner of the resulting dialog box
(Figure 4-2).

i®: VisualDSP++ License Manager v5.0.1.0

Setial Number | Famil | Seats Skatus |

HostID—
Mew, .. | &egister...l Walidate, .. | 11111111

Figure 4-2. Licenses Page Showing Host ID

Registering Your License

You must register full license and evaluation license serial numbers online
in order to receive a validation code.

If your machine has no Internet access, you can apply for a valida-
tion code from a machine with Internet access at the registration

page:

http://www.analog.com/processors/tools/register.
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Registering a Node-Locked License

To register a node-locked license:

1. Click the Windows Start button. Then choose All Programs ->
Analog Devices -> Visual DSP++ <version_number> -> Manage
Licenses. The Licenses page of the About dialog box appears.

2. From the list of serial numbers, select the serial number of the
license that you want to register.

3. Click Register.

Your system’s default browser is launched, and opens the Analog
Devices product registration Web page.

4. Fill in the required fields and submit the form.

A validation code will be e-mailed to you shortly.

Registering a Floating License

To register a ﬂoating license:

1. Click the Windows Start button. Then choose All Programs ->
Analog Devices -> Visual DSP++ <version_number> ->Visu-
alDSP++ Floating License Server -> Visual DSP++ License
Manager.

The Visual DSP++ License Manager application opens.

2. Select the ADI-prefixed serial number of the license that you want
to register.
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3. Click Register.

Your system’s default browser is launched, and opens the Analog
Devices product registration Web page.

4. Fill in the required fields and submit the form.

A validation code will be e-mailed to you shortly.
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Validating Your License

You must validate your license in order to make it permanent.

From Visual DSP++ 5 onwards, license strings (and therefore validation
codes) have changed in format. Consequently, when registering your serial
number and host ID, two validation codes will be e-mailed to you. One is
valid for VisualDSP++ 4.5 and earlier versions, and the other is valid for
Visual DSP++ 5 and later versions.

Ensure that you install the appropriate validation code for the
version of Visual DSP++ you are using. If you try to install the
wrong version, you will get the following error message

(Figure 4-3):

Vizual DSP++ [ %]

The validation code that you entered is invalid.
Please re-enter the code, ensuring that you type
the code EXACTLY as you received it. It might be
helpful to copy-and-paste vour validation code
rather than typing it manually.

Figure 4-3. Message: Invalid Validation Code
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Validating a Node-Locked License

This procedure assumes that you have received a validation code via e-mail
as described in Registering a Node-Locked License.

To validate a node-locked license:

1.

Click the Windows Start button. Then choose All Programs ->
Analog Devices -> Visual DSP++ <version_number> -> Manage
Licenses.

The About dialog box appears.
Click the Licenses tab.

Select the KIT- or ADI-prefixed serial number of the license that you
want to validate.

Click Validate.

The Enter Validation Code dialog box appears.

In Validation code, enter the validation code.

Tip: Prevent typos by copying-and-pasting the code string.
Click OK.

Upon successfully entering this validation code, a message indicates
that a permanent license has been created.
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Figure 4-4 shows that the node-locked license has been validated.

General  Licenses |\|’ersion5 I Support I
Serial Number | Famity | Status |
ADI-256-256-25625256-256  Blackfin Validated {Permanent}

e R R ”Homnnﬂﬂn
oK |

Figure 4-4. Visual DSP++ License Manager Showing a Validated
Node-Locked License

Validating a Floating License

This procedure assumes that you have received a validation code via e-mail
as described in Registering a Floating License.

To register a floating license:

1. Click the Windows Start button. Then choose All Programs ->
Analog Devices -> Visual DSP++ <version_number> -> Visu-
alDSP++ Floating License Server -> Visual DSP++ License
Manager.

The License Manager application opens.

2. Select the ADI-prefixed serial number of the license that you want
to register.

3. Click Validate.

The Enter Validation Code dialog box appears.
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4. In Validation code, enter the validation code.

Tip: Prevent typos by copying-and-pasting the code string.
5. Click OK.

Upon successfully entering this validation code, a message indicates
that a permanent license has been created.

Figure 4-5 shows that the floating license has been validated.

iw VisualDSP++ License Manager v5.0.1.0 = B3

Serial Number | Family | seats | stams
ADI-256-256-258'256256-2569 TigerSHARC 5 Server - Validated (Permanent)

E | B
Machine ID
Cloze | Mew. .. | Hegistery.. | alidate .. | 11111111

Figure 4-5. VisualDSP++ License Manager Showing a Validated Floating
License

You must now run the FLEXnet LMTOOLS application and re-read the
license.dat file from the Start/Stop/Reread tab.

To start FLEXnet LMTOOLS, from the Windows Start menu, choose
All Programs -> Analog Devices -> Visual DSP++ Floating License Server
-> FLEXnet LMTOOLS.

See Installing a Floating License Server for further details.
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5 CHECKING THE STATUS OF
YOUR LICENSE

This chapter describes each possible status for each type of Visual DSP++

license.

The chapter contains the following topics:
* Viewing a License’s Status
* Node-Locked Licenses

¢ (lient Licenses

Viewing a License’s Status

To view the status of node-locked licenses, from the Windows Start
menu, choose All Programs -> Analog Devices -> Visual DSP <ver-
sion_number> -> Manage Licenses.

To view the status of floating licenses, from the Windows Start menu,
choose All Programs -> Analog Devices -> Visual DSP++ Floating
License Server -> VisualDSP++ License Manager.
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You will see a screen similar to Figure 5-1.

[»] About 21=]

General  Licenses |\|’ersion5 I Support I

Serial Number | Famity | Status |
ADI-256-256-25625668-256  Blackfin Validated {Permanent}

e R R ”Hoamﬂﬂﬂn
oK |

Figure 5-1. Example: Licenses Page Showing a Validated License

Node-Locked Licenses

Node-locked licenses include:
e Full Licenses
e Evaluation Licenses

e Test Drive Licenses
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Checking the Status of Your License

Full licenses have serial numbers that are prefixed with ADI. Each full
license has a status, as described in Table 5-1.

Table 5-1. Full Licenses — Status Information

License Status Description
Not Validated This is a full license that expires in X (initially 30) days because it has
(Expiring in X days) not yet been validated.
You must validate this license to enable permanent use
of VisualDSP++; otherwise, the license will expire and VisualDSP++
will become inoperable.
Validated This is a full license. It has been validated for permanent use of Visu-
(Permanent) alDSP++.
Not Validated This license has not been validated. The 30-day grace period is over,
(Expired) and VisualDSP++ is inoperable.
You must validate the license to enable permanent use
of Visual DSP++.

Evaluation Licenses

Evaluation licenses have serial numbers that are prefixed with KIT.
Each evaluation license has a status, as described in Table 5-2.

Table 5-2. Evaluation Licenses — Status Information

where X is initially “10”

License Status Description
Demo - Full This is an evaluation license that expires in X (initially 10) days
(Expiring in X days) because it has not yet been validated.

You must validate this license to enable permanent use of Visu-
alDSP++; otherwise, the license will expire and VisualDSP++ will
become inoperable.

Demo - Full
(Expiring in X days)

where X is initially “90”

This is an evaluation license. It has been validated for permanent
use of VisualDSP++. The initial 90-day period of full license
evaluation will expire in X days. The license will then become
restricted.
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Table 5-2. Evaluation Licenses — Status Information (Contd)

License Status

Description

Demo
(Expired, Restricted)

This is an evaluation license. It has been validated, and the initial
90-day period of full license evaluation has expired.
You may use VisualDSP++ with EZ-KIT Lite debug sessions only.

Not Validated
(Expired)

This license has not been validated. The 10-day grace period is
over, and VisualDSP++ is inoperable.

You must validate the license to enable permanent use
of VisualDSP++.

Test Drive Licenses

Test drive licenses have serial numbers that are prefixed with TST.
Each test drive license has a status, as described in Table 5-3.

Table 5-3. Test Drive Licenses — Status Information

License Status Description

Test Drive This is a test drive license that expires in X (initially 90) days.

(Expiring in X days) You may use VisualDSP++ with emulator or simulator debug
sessions only. When the 90 days are up, VisualDSP++ will
become inoperable.

Test Drive This test drive license has expired.

(Expired)
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Client Licenses

When a client license is installed, its status is USE_SERVER. In addition, the
server name appears under Serial Number, and C1ient appears under

Family.
General  Licenses |\|’ersion5 I Support I
Serial Mumber |_Famity | Status |
EDINSMSM Client USE_SERVER

Host ID
Fiegister, . | alidate). | 1111111
oK |

Figure 5-2. Example: Licenses Page Showing a Client License
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6 TROUBLESHOOTING

This chapter provides answers to common licensing problems and
includes the following sections:

* Frequently Asked Questions (FAQs)

* Error Messages

For details on how to contact Support, refer to Licensing Support.

Visual DSP++ 5 Licensing Guide
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Frequently Asked Questions (FAQS)

This section provides answers to:
* General FAQs
* VisualDSP++ Floating License Server-Specific FAQs

General FAQs

Question: [ have lost my serial number. Where can I find it, or how do I get
a replacement?

Answer: Firstly, note that your serial number was printed on the card and
mailed to you after your VisualDSP++ purchase.

In addition, you can locate already installed serial numbers in the IDE by
going to:

Start -> All Programs -> Analog Devices -> Visual DSP++ <version_num-
ber> -> Manage Licenses

or

Start -> All Programs -> Analog Devices -> Visual DSP++ Floating
License Server -> Visual DSP++ License Manager if using a floating
license.

If you do not have Visual DSP++ installed and licensed, or have lost your
license serial card, e-mail support with details of the person and company
to whom the serial number was originally registered. For more informa-
tion, refer to Licensing Support.

Question: [ uninstalled VisualDSP++ due to a problem, and now when I'm
trying to reinstall my serial number I receive the message “The serial number

has already been used and can be installed only once”. What should I do?
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Answer: TST- and KIT- prefixed serial numbers may only be installed once
per machine.

If you have had to uninstall VisualDSP++ for any reason, note that unin-
stalling via Add/Remove programs in the Windows Control Panel leave
the <install_path>\System\license.dat file intact. Therefore, you can
simply copy and paste this file into the <install_path>\System folder of
your new instance of VisualDSP++. If you deleted all files in the install
path after uninstalling, check your recycle bin for the 1icense.dat file.

If you cannot find your original 1icense.dat file, contact Support with
the serial number that you are trying to reinstall. For more information,
refer to Licensing Support.

Back up your Ticense.dat file to prevent a similar problem.

Question: [ ve received the message “The serial number has already been used
and can be installed only once”, but I've never installed this number before.

What’s going on?

Answer: TST- and KIT-prefixed serial numbers may only be installed once
per machine. Possibly, someone else installed the serial number on this
machine in the past.

In addition, TST-prefixed serial numbers may not be installed if a KIT-pre-
fixed serial number for the same architecture is already installed (or has
ever been installed) on the same machine.

Contact Support with the serial number(s) in question, explaining the
situation. For more information, refer to Licensing Support.

Question: [ve just installed a full license or evaluation license and now I get
a message telling me that the license will expire in X days. I thought these were
permanent licenses?
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Answer: When permanent licenses are installed, they initially have only a
“temporary” status. In order to make them permanent, they must be vali-
dated. Refer to Registering and Validating Your License for further details.

Question: [ have just upgraded VisualDSP++ and the serial number I was
using previously is not accepted. Why?

Answer: Certain serial numbers have been made obsolete over the years.
Contact Support with your current serial number, and you will be issued a
replacement. For more information, refer to Licensing Support.

Question: [ need to transfer my license to a new machine (or, my hard drive
crashed and had to be reformatted). How do I register my license against a
new host ID?

Answer: To register additional computers, install your serial number on
the new machine and register it online with the new host ID at the address
below. You will then be sent a validation code by e-mail. Installing this
validation code will make your license permanent.

Web form: http://www.analog.com/toolsregistration.

If you receive a message about “...attempting to register more than the
allowed number of times...”, request a registration history update via
e-mail at processor.tools.registration@analog.com

Include the serial number(s) in question.

Question: How can I find out my registration history? That is, how do I find

out which machines my serial number(s) are registered against?
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Answer: To request an up-to-date registration history, send an e-mail with
the serial number(s) in question to:
processor.tools.registration@analog.com.

Question: [ registered for a test drive license but I have not yet received it.

Why?

Answer: If you registered for a test drive license for SHARC or Tiger-
SHARGC, the serial number will be displayed on the next Web page, after
clicking Register.

If you register for a Blackfin test drive license, the serial number will be
e-mailed to you.

In the event of a problem, contact Support. For more information, refer to
Licensing Support.

Question: [ have registered my evaluation license or full license, but have not
yet received a validation code via e-mail. Who should I contact?

Answer: This may have occurred because your e-mail address was not
entered accurately into the Web form. Contact Support. For more infor-
mation, refer to Licensing Support.

Question: [ve just upgraded to VisualDSP++ 5 and my existing validation
code isn’t accepted, even though I'm using the same machine that I registered
with. Why is this?

Answer: From Visual DSP++ 5 onwards, license strings (and therefore val-
idation codes) have changed in format. This means that you cannot install
a validation code created for an earlier version of Visual DSP++ in

version 5 environment.
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In order to receive a 5-compatible validation code, re-register your serial
number and host ID. You will then be e-mailed with two validation codes.
One is valid for VisualDSP++ 4.5 and earlier versions; the other is valid
for Visual DSP++ 5 and later versions. Ensure that you install the appro-
priate version.

For more information, refer to Registering and Validating Your License.

Question: The validation code that was e-mailed to me is being rejected.
What could be the problem?

Answer: Firstly, note that validation codes are valid for a particular serial
number and host ID combination. Therefore, if you are trying to install
your serial number on a second machine, you will have to register it with
the new host ID in order to receive the appropriate validation code.

Also, from VisualDSP++ 5 onwards, license strings, and therefore valida-
tion codes, have changed in format. This means that when you register
your serial number and host ID, you will be e-mailed with two validation
codes. One is valid for Visual DSP++ 4.5 and earlier versions, and the
other is valid for Visual DSP++ 5 and later versions. Ensure that you install
the appropriate version.

For more information, refer to Registering and Validating Your License.

Question: / have been using a test drive license for 36 days and have now
bought an EZ-KIT Lite. My simulator debug session still works but I cannot
connect to the EZ-KIT Lite debug session. Why not?

Answer: EZ-KIT Lite debug sessions are not supported by test drive
licenses (serial numbers prefixed with TST). You must install and register
the evaluation license serial number (prefixed with KI1T), which can be
found on a sticker affixed to the back of the CD sleeve that came with
your EZ-KIT Lite.

6-6
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Question: / have an evaluation license and was working with an
emulator/simulator debug session until today, when I started receiving error
messages. Why can't I connect to my emulator/simulator debug session any

2
more:

Answer: An EZ-KIT Lite license incorporates an initial 90-day full
license. Once the 90 days have passed, the evaluation license becomes
restricted, prohibiting simulator and emulator debug sessions and restrict-
ing the amount of internal memory that is available for code (program
memory). Refer to Licensing Overview for further details.

Question: I'm getting errors when trying to use VisualDSP++ with Remote
Deskrop. What could be the problem?

Answer: Visual DSP++ did not support connection through Remote Desk-
top before VisualDSP++ 5 and, in fact, actively disallowed it with
node-locked licenses prior to this release.

If you are using Visual DSP++ 4.5 or earlier, try using a single-session
remote access application, such as VNC. However, note that we offer no
support for this.

If you are using VisualDSP++ 5, you may still be unable to use remote
desktop if you used the advanced option to copy over your Ticense.dat
file from an earlier version of tools during installation of the latest tools. If
your license.dat was copied from an earlier release of the tools, we rec-
ommend that you rename you current license.dat file, which can be
found in the System folder of your VisualDSP++ 5 installation, to
license_old. Then you will need to reinstall your license number and
obtain a new, VisualDSP++ 5 compatible, validation code.
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Question: I'm running VisualDSP++ on Windows Vista (or Windows 7)
and having some problems with my license. I can’t find the license.dat file my
colleague installed. What's going on?

Answer: With the release of Windows Vista, Microsoft has introduced a
new security feature called User Account Control (UAC). UAC is a frame-
work that, when enabled, provides a more secure operating environment
for the user, which prohibits modification of critical system directories
and files. One of these directories is the Program Files directory into
which VisualDSP++ is installed when selecting the default setup options.

Licenses in Visual DSP++ are stored in a file called 1icense.dat located
within the System directory of your Visual DSP++ installation folder.
When installing a new license with UAC enabled, changes to the
Ticense.dat file will be redirected to the current user’s VirtualStore
directory. Because VirtualStore directories are specific to each user, this
has the added side effect that other users on the machine will not have
access to these licenses when using Visual DSP++.

To solve this, manually copy the Ticense.dat file from the first user’s
VirtualStore directory into the <install_path>\System directory. The
VirtualStore is located in:

C:\Users\<user_name>\AppData\lLocal\VirtualStore\Program
Files\Analog Devices\VisualDSP x.y\System.

where <user_name> is the name of the user who originally installed the
license, and x.y is the version of VisualDSP++ into which the license was
installed.

For details, refer to “Windows Vista Compatibility in VisualDSP++ 5.0
Development Tools” (EE-330) at
http://www.analog.com/en/processors-dsp/blackfin/products/appli-
cation-notes/resources/index.html.
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If using Windows 7 or later, refer to DOC-1190 on the FAQ page at
http://ez.analog.com.
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VisualDSP++ Floating License Server-Specific FAQs

Question: The LMTOOLS are asking for a *.lic file, but can’t find one. Why
not? I've already installed my serial number.

Answer: The LMTOOLS application accepts license files with both the
.Tic and .dat extension. By default, when browsing for a license file,
LMTOOLS looks for files with a . 11c extension. Simply change the Files

of type field to the .dat extension and you should find your 1icense.dat
file.

Question: How do I check whether my FLEXnet service is running?

Answer: This can be checked by starting the FLEXnet LMTOOLS and
clicking Perform Status Enquiry on the Server Status tab.

You can also check in the following way. Note the service name in the
Service Name field of the Config Services tab. Then go to Administrative
Tools in the Windows Control Panel and start the Services program. In
the list of services in the right-hand panel, check that the status of your
service is Started. If it is not, go to the Start/Stop/Reread tab in
LMTOOLS and click the Stop Server button and then click the Start

Server button.

If this also fails, locate the debug log file indicated on the Config Services
tab of LMTOOLS and send it to Support. For more information, refer to
Licensing Support.

Question: How do I use FLEXnet Licensing with more than one product?
Can I combine license.dat files?

Answer: Yes, FLEXnet can manage licensing for multiple products, and
there are several ways to achieve this. Full details on using FLEXnet licens-
ing with more than one product is outside the scope of this document;
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refer to the section entitled “Managing Licenses from Multiple Vendors”

in the FLEXnet Licensing End User’s Guide.
Should you require further assistance, contact Macrovision.

However, one method that has shown to be successful is to run the
FLEXnet server on one machine, running only one license server system.
In this case, ensure that each service run by LMTOOLS (including those
for products other than VisualDSP++) uses the same version of the
Imgrd.exe, and that 1mgrd.exe is the latest version installed.

This can be done by renaming the existing 1mgrd.exe in each vendor’s
FLEXnet (formerly named FLEXIm) folder, to move it out of the way, and
then copying in the latest version available to replace it. Alternatively, you
can change the Path to the Imgrd.exe field on the Config Services tab in
LMTOOLS for each service, so that it points to the most up-to-date
Tmgrd.exe file.

Question: How do I move my Floating License Server to a new machine?

Answer: Set up your new license server(s) and reinstall your client licenses
to point to this new server (as outlined in Installing a Floating License
Server). Re-register each serial number with the host ID of the new server
(Registering and Validating Your License). Once you have done this,
e-mail processor.tools.registration@analog.com, requesting that the
old machine(s) be removed from your registration history. Be sure to
include all relevant serial numbers and host IDs. A registration history will
be provided upon request.

Once your new server is up and running, disable the old server.

Question: [ve upgraded to VisualDSP++ 5 and also need to upgrade
my Server License software. Will I still be able to use older versions of
VisualDSP++ with the new version of the server software?
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Answer: The Floating License Server is compatible with all VisualDSP++
versions greater than and including Visual DSP++ 4.0.

If anyone on your network is working with the ADSP-218x or
ADSP-219x architectures and therefore needs to run Visual DSP++ 3.5
for 16-bit Processors, refer to the following question/answer, or contact
Support for assistance. For more information, refer to Licensing Support.

Question: You state that the latest version of the Floating License Server tools
are not compatible with VisualDSP++ 3.5. However, I need to use
VisualDSP++ 3.5 for 21xx on the same network as I'm using

VisualDSP++ 5. Is there a way around this?

Answer: There are a number of ways to do this; one example is given
below. If this does not cover your particular circumstance, contact Sup-
port. For more information, refer to Licensing Support.

Example: If you have an existing installation of VisualDSP++ 3.5 that uses
floating licenses, do the following:

1. Save the existing 1icense.dat file on your server to a safe place,
as a precaution.

2. Disable and uninstall your license server tools.

Note that uninstalling the Floating License Server tools (formerly
known as the License Server Manager) from Add/Remove pro-
grams leaves the install path, and your 1icense.dat file, intact in
the C:\Program Files\Analog Devices\VisualDSP\LMSERVER
directory. This means that you can re-use your original
Ticense.dat file.

3. Inyour license.dat file, comment out any license strings for any
architectures other than 21xx. This can be done by placing a “#”
at the start of each line; for example:
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# FEATURE FRIO-FULL analogd 1.0 3-aug-2007 5 DDDDEEEEFFFF \
# VENDOR_STRING=ADI-111-11111-111111-10

# INCREMENT FRIO-FULL analogd 1.0 permanent 5 AAAABBBBCCCC\
# VENDOR_STRING=ADI-111-11111-111111-10

Note: License strings can be found after the line:
## Begin FEATURE definitions”.

4. Install the latest version of the Floating License Server (currently
version 5.0.1.x). Since your original 1icense.dat file should still
be in the C:\Program Files\Analog Devices\VisualDSP\LMSERVER
directory, the new tools should detect it, and any further serial
numbers installed through the VisualDSP++ License Manager will
be appended to it.

5. Re-install any SHARC, TigerSHARC, or Blackfin serial numbers
you wish to use. Be sure to register and validate them within 30

days.
6. Use FLEXnet LMTOOLS to configure and run the License Server.

See Installing a Floating License Server for further details of how to per-
form the above procedure. If you have problems with the above procedure
or have any questions, contact Support.

Question: / have to add additional licenses to the License Server. How do I do
this?

Answer: The license server must be stopped first via the FLEXnet
LMTOOLS STOP/START/READ utility in the Configure Services win-
dow. Then follow the procedure as outlined in Task 2: Installing a Server
License. You must then restart the server.

Visual DSP++ 5 Licensing Guide 6-13



Frequently Asked Questions (FAQS)

Question: How do I install both a node-locked license and floating license on
the same machine?

Answer: Follow this procedure.

1. Install and validate (if necessary) your node-locked license on your

client machine. Follow the procedure outlined in Installing a
Node-Locked License.

. Install and validate your floating license on your server machine.

Follow the procedure outlined in Installing a Floating License
Server.

. Copy the “# Begin FEATURE” section along with the node-locked

license string from <install_path>\System\license.dat on the
client machine to the end of the “# Begin FEATURE” section of the
\VisualDSP\LMSERVER\1icense.dat file on your server machine.

. Install the client 1icense.dat file part of your floating license on

the client machine by following the procedure outlined in Install-
ing a Floating License Server. This will replace your node-locked
license.dat file with one that simply points to the server. The
existing 1icense.dat file will be renamed to Ticense.bak so that
the information contained in it is preserved.

Note: Users on other client machines may receive an error message
regarding the node-locked license, should all floating licenses be in
use at the time they try to check one out.

For further information, refer to Q&A article QA0000555 in the
Processors and DSP Knowledge Base on the Analog Devices Web
site at

http://www.analog.com/processors/knowledgebase.
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Question: 'm having trouble getting my floating license to work. My server
machine and/or my client machine has a firewall running. Could this be the

problem?

Answer: Yes. You may need to make some changes to your floating license
setup in order to workaround this. Contact Support for further
information.

Question: 'm installing a floating license and Corporate IS policies prohibit
shared network folders on my server machine. Are there any alternatives to
installing client licenses?

Answer: Yes. An alternative method of installing a client license, which
doesn’t require the creation of a shared network folder or use of the Visu-
alDSP++ GUI, is to simply copy the
<server_install_path>\LMSERVER\client-Ticense.dat file to each client
machine’s <install_path>\System folder, and rename it to Ticense.dat.

Error Messages

This section describes:
* General Error Messages
e VisualDSP++ Floating License Server-Specific Errors

*  Warning Messages

General Error Messages
General error messages include:
e Errors Issued in Message Boxes

e Errors Issued in the Output Window or on the Command Line
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Errors Issued in Message Boxes

Problem: The serial number has already been used and can be installed only
once.

Solution: The serial number you are trying to install has already been
installed on this machine. Note that evaluation and test drive serial
numbers may only be installed once per machine. In addition, test drive
serial numbers may not be installed if an evaluation license for the same
architecture has already been installed on that machine. For further infor-
mation, refer to Licensing Overview.

Problem: 7he serial number already exists. You will need to register the serial
number to receive a validation code. If you already have a validation code,
select the serial number and click the Validate button.

Solution: VisualDSP++ found the serial number you entered; it is already
in the Ticence.dat file. If you have already installed that serial number
but have not yet registered it and received a validation code, follow the
steps outlined in Registering and Validating Your License.

Problem: The serial number you entered is invalid. Please re-enter the num-
ber, ensuring that you type the number EXACTLY as shown on the

registration card.

Solution: Ensure that you have typed in the correct serial number, exactly
as given. If you continue to have problems, contact Support, sending your
serial number and <install_path>\System\license.dat file, if avail-
able. For more information, refer to Licensing Support.
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Problem: The serial number you have entered is no longer valid. Please
contact Support (dsptools.support@analog.com or 1-800-analogd) to update
your serial number.

Solution: VisualDSP++ has detected that the serial number you are trying
to install is no longer valid. Certain serial numbers have been made obso-
lete over the years. Contact Support with your current serial number, and
you will be issued with a replacement. For more information, refer to
Licensing Support.

Problem: VisualDSP++ has detected an invalid serial number. Please verify
the serial number is accurate with the one received with the VisualDSP++
product. If the problem persists, please contact Analog Devices' technical sup-
port at http://www.analog.com/support.

Solution: Visual DSP++ detected an invalid serial number in your
license.dat file. This error can occur when your 1icense.dat file con-
tains a once-valid serial number that has been made obsolete in later
versions of VisualDSP++. In this case, contact Support with your current
serial number and you will be issued a replacement serial number. For
more information, refer to Licensing Support.

Problem: The serial number you entered is a Server serial number. Please run
the server license installation program tro use this serial number.

Solution: The serial number you are trying to install is a floating license
serial number. This must be installed through the separate Floating
License Server application, rather than through the Visual DSP++ IDDE.
Refer to Installing a Floating License Server for further details.
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Problem: The validation code that you entered is invalid. Please re-enter the
code, ensuring that you type the code EXACTLY as you received it. It might be
helpful to copy-and-paste your validation code rather than typing it manually.

Solution: VisualDSP++ detected that you entered an invalid serial num-
ber. Ensure that you have entered the correct validation code, exactly as
given.

Validation codes are valid for a particular combination of serial
number and host ID. If you are trying to install your serial number
on a different machine than the one you initially registered, you
will need a new validation code. Refer to Registering and Validat-
ing Your License for further details.

From Visual DSP++ 5 onwards, license strings (and therefore validation
codes) have changed in format. Consequently, when registering your serial
number and host ID, two validation codes will be e-mailed to you. One is
valid for Visual DSP++ 4.5 and earlier versions; the is valid for

Visual DSP++ 5 and later versions. Ensure that you install the appropriate
validation code for the version of VisualDSP++ you are using.

If you continue to have problems, e-mail processor.tools.registra-
tion@analog.com, identifying your serial number, validation code, and

host ID.

Problem: The file does not contain valid client license information.

Solution: Visual DSP++ detected an invalid client license file. Ensure that
you select the correct client-1icense.dat file.

Problem: The filename as entered could not be found. Ensure that the path is
correct and the file exists.
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Solution: Visual DSP++ detected that an invalid path or file name has been
entered for the location of the c1ient-Ticense.dat file. Ensure that the
path is correct and the file exists.

Problem: Error: Cannot find a valid license path

Solution: VisualDSP++ was not able to find the given path to the
license.dat file. This indicates that the registry setting that stores the
location of your Ticense.dat file is incorrect, missing, or has been cor-
rupted. Try uninstalling, rebooting, and reinstalling VisualDSP++.

If the problem persists, contact Support for further assistance. For more
information, refer to Licensing Support.

Problem: Failed to delete the license file: C:\Program Files\Analog

Devices\VisualDSP++ <version_number>\System\license.dat
-— Or -—

Failed to copy the license file to: C:\Program Files\Analog Devices\Visu-
alDSP++ <version_number>\System\license.client_backup

- Or -

Failed to open the license file: C:\Program Files\Analog Devices\Visu-
alDSP++ <version_number>\System\license.dat

— Or —

Failed to copy the license file to C:\Program Files\Analog Devices\Visu-

alDSP++ <version_number>\System
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Solution: VisualDSP++ had a problem accessing the 1icense.dat file
located in the <install_path>\System folder. This can be caused by the
System folder, parent folders, or the 1icense.dat file itself having
read-only permission, by the file currently being held open by another
application, or by another disk/file access problem. Verify that the file and
folders have the proper settings to enable copying files and try again.

If the problem persists, contact Support for further assistance. For more
information, refer to Licensing Support.

Problem: /nvalid license file. The license file may either be damaged or
missing. Please confirm that the following file exists:
C:\Program Files\Analog Devices\VisualDSP++

<version_number>\System\license.dat

Solution: VisualDSP++ had a problem accessing the 1icense.dat file
located in the <install_path>\System folder. This can be caused by the
System folder, parent folders, or the 1icense.dat file itself having
read-only permission, by the file currently being held open by another
application, or by another disk/file access problem. Verify that the file and
folders have the proper settings to enable copying files and try again.

This can also be caused by a Ticense.dat file that includes invalid
information.

If the problem persists, contract Support for assistance. For more
information, refer to Licensing Support.

Problem: Error: Failed to get a valid host id

Solution: VisualDSP++ was not able to get a valid host ID from your

computer, which is a modified version of the volume serial number. From
the C:\ drive, try running the “vol” command from the command prompt
to verify that you have a physical hard drive with a volume serial number.
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If you do not have a hard drive (or if your setup results in you having no
C:\ drive), run ipconfig/all from the command prompt to verify that
you have a MAC address (the physical address of the network card). If you
have a volume serial number or a MAC address, try uninstalling, reboot-
ing, and reinstalling Visual DSP++ to see whether that fixes the problem.

If the problem persists, contact Support for further assistance. For more
information, refer to Licensing Support.

Errors Issued in the Output Window
or on the Command Line

Problem: Error code: 0x80040112
Error description: Target not licensed for use

Solution: This error is issued when trying to connect to a debug session.
Visual DSP++ was not able to find a license for the specific processor type
with which you are currently working.

This means that your license is not installed correctly or that you are
attempting to run a debug session for which you are not licensed.
Examples of the latter problem include attempting to run a SHARC
debug session when you only have a Blackfin license installed, or
attempting to run an EZ-KIT Lite debug session when you only have a
test drive license installed.For more information, refer to Licensing
Overview.

Problem: Error: cc1458:
Fatal Error: could not obtain license

Solution: This error is caused by the compiler. The compiler could not
find a 1icense.dat file. Ensure that your license is correctly installed and
that it is for the same architecture as the target processor of the project you
are trying to build. Contact Support if you require further assistance. For
more information, refer to Licensing Support.
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Problem: /Error: eal 156]
Failed to get a license to run the assembler

Solution: This error is issued by the assembler. The assembler could not
find a valid 1icense.dat file. Ensure that your license is correctly installed
and that it is for the same architecture as the target processor of the project
you are trying to build. Contact Support if you require further assistance.
For more information, refer to Licensing Support.

Problem: Error [i1143
Failed to obtain license

Solution: This error is issued by the linker. The linker could not find a
valid 1icense.dat file. Ensure that your license is correctly installed and
that it is for the same architecture as the target processor of the project you
are trying to build. Contact Support if you require further assistance. For
more information, refer to Licensing Support.

Problem: Error li1042
22742 (more than 22K) are used by code, while only 20KB are allowed under
EZ-KIT Lite license restriction

Solution: This error is caused by the linker. Evaluation licenses restrict the
amount of internal program memory that is available to the processor.
The exact amount that is available varies with each EZ-KIT Lite. If you
want to increase the available memory, upgrade to a full license. For fur-
ther information, refer to the EZ-KIT Lite manual.
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VisualDSP++ Floating License Server-Specific Errors

VisualDSP++ Floating License Server-Specific errors include:
e Errors Issued in Message Boxes

* Errors Issued by FLEXnet Tools

Errors Issued in Message Boxes

Problem: 7he license manager has detected that a server license is being used
and that there is a problem communicating with the license server software.
This could be due to an out-of date version of the license server software or
there is not a network connection with the license server. Please check your
connection to the network or if your the server software is out-of-date update
the server tools using the latest license server installation.

The license server installer can be downloaded from
hitp:/fwww.analog.com/en/processors-dsp/software-and-reference-designs/con-
tentlvisualdsp_tools_upgrades/fca. html.

Solution: VisualDSP++ has detected a problem while communicating
with the VisualDSP++ Floating License Server. This error is usually
followed by a second error, headed “Flexible License Manager”, which
gives specific FLEXnet error codes, and which may help you narrow down
the problem when referring to the FLEXnet Licensing End User's Guide.

Likely causes include:
* A problem with your connection to the network

* The instructions outlined in Installing a Floating License Server
have not been followed correctly

e The version of the License Server Manager you are using is not a
recent enough version for the version of Visual DSP++ that you are
using. For VisualDSP++ 5, version 2.00.7 or later must be
installed.

Visual DSP++ 5 Licensing Guide 6-23


http://www.analog.com/dsp/tools/updates
http://www.analog.com/dsp/tools/updates
http://www.analog.com/dsp/tools/updates

Error Messages

e The FLEXnet service is not running

For details on how to check this, refer to the FAQ entitled “How
do I check whether my FLEXnet service is running?”

* A firewall is running on one or both machines. If so, contact
Support for information on working with FLEXnet licensing with
firewalls. For more information, refer to Licensing Support.

* More than one application that uses the FLEXnet (previously
known as FLEXIm) License Tools is running on the network.

If this is the case, review the FLEXnet Licensing End User’s Guide,
which has a section entitled “Managing Licenses from Multiple
Vendors”. Note that for most setups, only one version of
Imgrd.exe should be run on any network, and that version must be
the latest one installed. See also the FAQ entitled “How do I use
FLEXnet Licensing with more than one product?”.

Problem: The serial number already exists.

Solution: The VisualDSP++ License Manager has detected that the serial
number you are trying to install already exists in your 1icense.dat file.

Problem: The serial number entered is not a server serial number. Please
enter a serial number that was created for the server.

Solution: The VisualDSP++ License Manager has detected that the serial
number you are trying to install is a node-locked license serial number.
The Floating License Server is not required for use with this type of
license.

Install your node-locked license through the Visual DSP++ IDDE. Refer
to Installing a Node-Locked License for further details.
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Problem: The serial number you entered is invalid. Please re-enter the
number, ensuring that you type the number EXACTLY as shown on the

registration card.

Solution: Ensure that you have typed in the correct serial number, exactly
as given. If you continue to have problems, contact Support, sending your
serial number and <install_path>\System\license.dat file, if available.
For more information, see Licensing Support.

Problem: The serial number you have entered is no longer valid. Please
contact Support (dsptools.support@analog.com or 1-800-analogd) to update
your serial number.

Solution: The VisualDSP++ License Manager has detected that the serial
number you are trying to install is no longer valid. Certain serial numbers
have been made obsolete over the years. Contact Support with your cur-
rent serial number, and you will be issued with a replacement. For more
information, see Licensing Support.

Problem: 7he validation code that you entered is invalid. Please re-enter the
code, ensuring that you type the code EXACTLY as you received it. It might be
helpful to copy-and-paste your validation code rather than typing it manually.

Solution: The Visual DSP++ License Manager has detected that you
entered an invalid validation code. Enter your validation code exactly as
given.

Validation codes are valid for a particular serial number and

host ID combination. If you are trying to install your serial number
on a different machine than the one you initially registered, you
will require a new validation code. Refer to Registering and Vali-
dating Your License for further details.
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From VisualDSP++ 5 onwards, license strings (and therefore validation
codes), have changed in format. Consequently, when registering your
serial number and host ID, two validation codes will be e-mailed to you.
One is valid for VisualDSP++ 4.5 and earlier versions; the other is valid
for VisualDSP++ 5 and later versions. Ensure that you install the appro-
priate validation code for the version of Visual DSP++ you are using.

If you continue to have problems, e-mail processor.tools.registra-
tion@analog.com, identifying your serial number, validation code, and

host ID.

Problem: Invalid license file. The license file may either be damaged or miss-
ing. Please confirm that the following file exists:
C:\Program Files\Analog Devices\Visual DSP\LMSERVER\license.dat

Solution: The Visual DSP++ License Manager had a problem accessing the
Ticense.dat file located in the <install_path>\LMSERVER folder. This can
be caused by the LMSERVER folder or the Ticense.dat file itself having
“read only” permission, by the file currently being opened by another
application, or by another disk/file access problem. Verify that the file and
disk drive have the proper settings to enable copying files and try again.

This can also be caused by the Ticense.dat file including invalid
information.

If the problem persists, contact Support for further assistance. For more
information, see Licensing Support.

Problem: Failed to copy the license file to license.bak

Solution: The Visual DSP++ License Manager was not able to create the
backup license file <install_path>\LMSERVER\1icense.bak. This can be
the result of a read/write permission issue on the LMSERVER folder in the
Visual DSP++ install directory, a lack of disk space, the file attributes on

6-26 Visual DSP++ 5 Licensing Guide



Troubleshooting

<install_path>\LMSERVER\1icense.dat being set to hidden, or another
disk/file access problem. Verify that the file and disk drive have the proper

settings to enable copying files and try again.

If the problem persists, contact Support for further assistance. For more
information, see Licensing Support.

Problem: Error: Failed to get a valid host id

Solution: The VisualDSP++ License Manager was not able to get a valid
host ID, which is a modified version of the volume serial number, from
your computer. From the C:\ drive, try running the “vol” command from
the command prompt to verify that you have a physical hard drive with a
volume serial number. If you do not have a hard drive (or if your setup
results in you having no C:\ drive), run ipconfig/all from the command
prompt to verify that you have a MAC address (the physical address of the
network card). If you have a volume serial number or a MAC address, try
uninstalling, rebooting, and reinstalling VisualDSP++ to see whether that
fixes the problem.

If the problem persists, contact Support for further assistance. For more
information, refer to Licensing Support.

Problem: The application failed to initialize properly OR Can't find DLL
MSVCP80.DLL

Solution: These errors can be an indication that the Microsoft Visual C++
2005 SP1 Redistributable package has not been installed as part of the
Floating License Server as it should be.

The package can be downloaded from:
http://www.microsoft.com/downloads/details.aspx?Fami-
1yID=200B2FD9-AE1A-4A14-984D-389C36F85647&displaylang=en.
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Errors Issued by FLEXnet Tools

ERROR: No such feature exists.

Feature: VDSP-DEBUGGER

Licensze path: Ci'\Program Files‘anzlog Devices\WisuzIDSP 5.0 0707131 -
"Systemlicenze. dat

FLEXnet Licensing efror:-5,417

For further information, refer to the FLEXnet Licensing End User Guide,

available at "www.macrovision.com™,

Figure 6-1. Example: FLEXnet Tools Error Message

For information on resolving errors issued directly by the FLEXnet
licensing tools (Figure 6-1), refer to the FLEXnet Licensing End User
Guide, which is installed with both VisualDSP++ 5 and Floating License

Server software.

In the VisualDSP++ 5 installation, this document is located in the
<install_path>\Docs\flex folder.

In the Floating License Server installation, this document is located in the
<install_path>\LMSERVER folder.
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Warning Messages

Warning messages include:
* Warnings that Display in Message Boxes
e Warnings that Display in the Output Window or on a Command
Line
Warnings that Display in Message Boxes

Problem: The following serial number will expire in x days.

ADI-152-256-999999999-0000
— Or —

The following serial number expires today.
ADI-152-256-999999999-0000

Solution: The given serial number has not yet been validated and will
expire in x days (or today). Refer to Registering and Validating Your
License for further details.

Problem: C:\Program Files\Analog Devices\VisualDSP++ <version_num-
ber>\System\license.dat already exists.

The file will be renamed to license.bak and the new file will be added.

Solution: The warning is issued when an existing 1icense.dat file has
been detected and is being replaced. This happens whenever you validate
an existing license or add a new license.
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Warnings that Display in the Output Window
or on a Command Line

Problem: /Informational eal154]

License to use this tool will expire in x days

Solution: The assembler has detected that your license will expire in x
days. If you have an evaluation license or a full license, register and vali-
date it.
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If you are still experiencing a problem after having tried to solve it using
the information in this guide, you can contact Analog Devices Customer
Support for assistance.

The chapter contains the following sections:
* Information Required by Support
e E-Mail Support
* Telephone Support

Information Required by Support

When contacting Support regarding a licensing issue, please send the fol-
lowing information if e-mailing (or have it available if telephoning):

* Version of Visual DSP++ and update (if any)
* License serial number(s) in question
e <install_path>\System\license.dat file (if available)

* Screen captures of encountered error messages
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E-

Floating Licenses
If you are using a floating license, also provide the following information:

* Version of the Floating License Server
This is displayed in the title bar of the Start -> All Programs ->
Analog Devices -> Visual DSP++ Floating License Server ->
VisualDSP++ License Manager dialog box.

* <server_install_path>\<your_name>\1icense.dat file
* <server_install_path>\<your_name>\*.1og file

* Screenshots of encountered error messages

Mail Support

You can obtain support via e-mail as follows.
Registration Support:

Contact Registration Support if you have any problems with registering or
validating your license serial number, or if you have lost your license serial
number. Use the following e-mail address:
processor.tools.registration@analog.com.

Processor Tools Support:

For all other queries regarding Visual DSP++ licensing, contact Processor
Tools Support. Use the following e-mail address:

processor.tools.support@analog.com.

Telephone Support

In the USA only, licensing inquiries can be made to the following toll-free
phone number: 1-800-ANALOGD (800-262-5643)
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